
 1

 

Procurement Card - Small Purchase Visa Card 
Splitting a Transaction Between Two Cost Centers/Internal Orders 

The University of Mississippi 
End User Documentation – ERP 2005 

6/2008 
 
 

Splitting a Transaction Between Two Cost Centers/Internal 
Orders 
 
R/3 Path > Accounting > Financial Accounting > General Ledger > 

Document > Parked document > Post/delete [double-click] 
Transaction 
Code 

FBV0 

NOTE: PK (Posting Keys) – 40 for debits 
                                  50 for credits 

NOTE: Do not save/post the document until ALL changes have been 
made. 

NOTE: The posting date must be changed to the actual date that the 
document is being posted. 

Open Document 
Company Code 1 
Document Number Provided in the E-mail  
Fiscal year Enter current Fiscal year 
Enter Left click on Enter Icon or press enter on the keyboard. 
NOTE: If you don’t know the document number, see Overview handout. 

Change Posting Date 
Change Posting Date The posting date must be changed to the actual date that the 

document is being posted (follow steps A - C). 
A – Document 
header Icon 

Left click on Document header Icon (Hat). 

B – Posting date Change posting date, but ONLY the posting date. 
C - Return Return to previous page, use back arrow icon or overview icon. 
Error(s) If you receive an error message call Shelley @ 7449. 
By using the back arrow or overview icon - this should take you to the “Post Parked 
Document:  Overview” screen. 
Select Transaction Double click on the transaction to be changed. 
This will take you to the “Post Parked Document: Change G/L Account Item 
Press “Ctrl-Y” Place the cross-cursor in the top left hand corner of the amount 

field. (View SAP Screen Shot – page 7). 
Highlight Drag the cross-cursor with your mouse to select the entire section 

of data. 
Press “Ctrl-C” Press the “Ctrl-C” on the keyboard to copy the data. 
“Next line item” Under the “Next line item” section, re-post the transaction by 

entering in the same posting key (either “40” or “50” and entering 
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the new G/L account number. 
Enter Left click on the Enter icon or press the Enter on your keyboard. 
This will take you to the “Post Parked Document: Enter G/L Account Item 
Press “Ctrl-V” Place your cursor at the very beginning of the amount field.  Press 

“Ctrl-V” on your keyboard to paste the data you copied earlier.   
Verify Verify everything posted correctly.  
Change amount Change the amount. 
“More” Icon Left click on the “More” Icon. 
Coding Block At the “Coding Block” screen, wipe out the data in all fields. 
Business Area  Enter appropriate Business Area. 
Cost Center/Internal 
Order 

Enter appropriate Cost Center/Internal Order. 

Enter Left click on green check (bottom of box) or press enter on 
keyboard. 

Posting Keys Under the “Next line Item” section, re-post the transaction by 
entering in the same posting key (either “40” or “50”) and 
entering the G/L account number. 

Enter Left click on the Enter icon or press enter on enter on keyboard. 
Second Blank Screen should appear  - repeat the same steps 
Paste Ctr-V to paste 
Change Amount Change amount. 
More Icon Left click on more icon. 
Delete Data At the “Coding Block” screen, wipe out the data in all fields. 
Business Area Enter appropriate business area. 
Cost Center/Internal 
order 

Enter appropriate cost center/internal order 

Enter Left click on green check (bottom of box) or press enter on 
keyboard. 

Overview Screen Left click on back arrow icon or overview icon – this should take 
you back to the “Post Parked Document:  Overview” screen. 

Original Line Item Single left click on the line item you just split. 
Delete Original Line 
Item 

Menu Path on the Top Blue Line 
     > Edit > Delete item 

NOTE: If you split a line item between two different business areas, you 
must also split the VISA line.  This entails creating a second 
VISA line. (See pages 12 - 17 

SAVE If you did not split the VISA line and all changes have been 
made.  Left click on the SAVE icon (diskette). 
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Splitting a Transaction Between Two Cost Centers/Internal 
Orders 
 
R/3 Path:  Accounting > Financial Accounting > General Ledger > 
Document > Parked documents > Post/delete 
 
 
 
 

 
 
 
OR use Transaction Code:  FBV0 
 
 

 
 
 
 
 
 

> Accounting 
  > Financial Accounting 
    > General Ledger 
      > Document 
        > Park documents 
          > Post/delete 
             [double click] 

Use Command Field for Transaction Code 
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Open Document 
 
 
Company code – 1 
 
Document number – Provided in e-mail. 
 
Fiscal year – Enter current fiscal year. 
 
Enter – Left click on Enter Icon or press enter on the keyboard. 
 
 

 

 
 
 
NOTE:  If you don’t know the document number, see Overview handout. 
 
 
 
 

Company Code is always “1”      1 

Provided in e-mail                2 

Fiscal year      3 

Enter         4 
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Change Posting Date 
 

 
Change Posting Date  – The posting date must be changed to the actual 
date that the document is being posted (follow steps A - C). 
 
A - Header Icon – Left click on Document Header icon (Hat). 
 

 
 
B - Posting date – Change posting date, but ONLY the posting date.  Back 
Arror.  Answer “No”. 
 

 
 
 
 

Document Header 

Posting Date 
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C - Return to previous page, use back arrow icon or overview icon. 
 
Select Transaction:  At the Post Parked Document: Overview screen, 
double click on the transaction to be changed. 
 

 
 
Copy Data:  At the “Post Parked Document:  Change G/L Account Item” 
screen, press “Ctrl-Y” on the keyboard.  Place the cross-cursor in the top left 
corner of the amount field.  Drag the cross-cursor with your mouse to select 
the entire section of data.   
 

Double click on the 
transaction to be changed. 
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Example of highlighted area.  Once data is highlighted, “Ctrl-C” to copy 
data. 
 

 
 
 
Posting Key: Under the “next line Item” section, re-post the transaction by 
entering in the same posting key (either “40” or “50”) and entering the G/L 
account number. 
 

Place the cross-cursor in the top left-hand 
corner of the amount field.    1 

Drag the cross-cursor 
with your mouse to 
select the entire 
section of data.    2
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Enter – Left click on the Enter icon or press the Enter on your keyboard. 
 
Example of screen: 
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Paste Data:  At the “Post Park Documents: Enter G/L Account Item” 
screen, place your cursor at the very beginning of the amount field.  Press 
“Ctrl-V” on your keyboard to paste the data you copied earlier.   
 
Verify Data:  Verify everything posted correctly. 

 
Change Amount:  Change amount, then left click on “More” Icon. 
 

 
 
 

“More” Icon 
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Coding Block:  At the “Coding Block” screen, wipe out the data in all of the 
fields. 
 

 
 
Example:  All fields blank. 
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Business Area & Cost Center/Internal Order:  Enter the new Business 
area and Cost Center/Internal Order. 
 
Note:  Order = Internal Order in the “Coding Block”. 
 

 
 
Enter – Left click on Green check (bottom of box) or press enter on 
keyboard. 

 
 
Posting Keys:  Under the “next line Item” section, re-post the transaction by 
entering in the same posting key (either “40” or “50”) and entering the G/L 
account number. 
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Enter – Left click on the Enter icon or press the Enter on your keyboard. 
Second Blank Screen should appear – repeat the same steps. 
 
Paste - Ctrl-V to paste. 
Change Amount – Change amount. 
More Icon – Left click on more icon. 
Deleted data  – blank out all data on the screen. 
Business Area and Cost Center/Internal Order - Enter second business 
area and cost center/internal order. 
Enter – Press enter on keyboard. 
 
Go back to “Post Parked Document: Overview” screen – Left click on 
back arrow icon, or overview icon - this should take you back to the “Post 
Parked Document:  Overview” screen. 
 
Original Line item – Single left click on the line item you just split (your 
cursor should be on the line item).  
 
Delete original line – Menu Path on the Top Blue Line  
                                           > Edit >Delete item 
 

  
Note:  If you split a line item between two different business areas, you must 
also split the VISA line.  This entails creating a second VISA line.   
 
If you did not split the VISA line and all changes have been made – SAVE. 
 
 
 
 
 
 
 
 
 
 
 

Edit  
  Delete item 
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Splitting the VISA Line 
 
Select Appropriate VISA line:  Double click on the appropriate VISA line 
transaction. 
 

 
 
At the “Post Parked Document:  Change G/L Account Item” screen, press 
“Ctrl-Y” on the keyboard.  Place the cross-cursor in the top left corner of the 
amount field.  Drag the cross-cursor with your mouse to select the entire 
section of data.   

 
 
 

Place the cross-cursor on the top 
left corner of the amount field. 

Drag the 
cross-cursor 
with your 
mouse to 
select the 
entire 
section of 
data. 
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Example of highlights area.  Once data is highlighted, “Ctrl-C” to copy data. 
 

 
 
Under the “next line item” section, re-post the transaction by entering in the 
same posting key (either “40” or “50”) and entering the G/L account number 
(22197 – ALWAYS for VISA). 
 

 
 
Enter – Left click on the Enter Icon or press enter on the keyboard. 
 
At the “Post Park Documents: Enter G/L Account Item” screen, place your 
cursor at the very beginning of the amount field.  Press “Ctrl-V” on your 
keyboard to paste the data you copied earlier.  Verify everything posted 
correctly. 
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Change Amount – Change amount to fit the appropriate business area.   
 
Posting Keys - Under the “next line item” section, re-post the transaction by 
entering in the same posting key (either “40” or “50”) and entering the G/L 
account number (22197 – ALWAYS for VISA). 
 
Enter – Left click on the Enter Icon or press enter on the keyboard. 
 
Repeat steps again. 
Ctl-V – Paste  
Change amount - Change amount to match appropriate business area 
(business area also may need to be changed – example:  Changing from 10 
to 30). 
 
Go back to “Post Parked Document: Overview” screen – Left click on 
back arrow, this should take you back to the “Post Parked Document:  
Overview” screen.   
 
Out of Balance - Your document should be out of balance by the amount of 
VISA document. 
 
VISA Line -  Left click once on the appropriate VISA Line.   
 
Delete Visa Line -   > Edit > Delete Item 
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Balance – Check Overview screen, it should now be in balance. 
 
VISA Line – Double click on Visa Line that you just deleted. 

 
 
 
 

Out of Balance  1 

Click on appropriate 
VISA line    2 

Double click on the 
line you just deleted. 
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Additional Data – Double click on “Additional Data” icon. 
 

 
 
Reference key 3 – Highlight and copy Reference key 3 date (Ctr-l C to 
copy).   
 

 
 
Go back– Left click on back arrow, this should take you back to the “Post 
Parked Document:  Overview Screen. 
 
 
 
 
 
 
 

“Additional Data” Icon 

Reference key3 - Date 
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VISA Line – Double click on the first VISA Line that you created.  This 
will take you to the “Post Parked Document:  Change G/L Account Item” 
Screen.  Left click on the “Additional Data” icon – your screen should look 
like this: 
 

 
 
Post Reference key 3 date (Ctr-l V to Paste). 
 
Go back to “Post Parked Document: Overview” screen – Left click on 
back arrow, this should take you back to the “Post Parked Document:  
Overview” screen. 
 
Repeat steps again for Other VISA lines you entered. 
 
VISA Line – Double click on appropriate Visa Line (second Visa Line). 
Additional Data – Double click on “Additional Data” icon (located on the 
function bar). 
 
Reference key 3 -  Left click in the Reference key 3 field. 
 
Post Reference key 3 date (Ctr-l V to Paste). 
 
Go back to “Post Parked Document: Overview” screen. 
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If the Overview Screen is in balance – SAVE 
 

 


